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How do i add check boxes in word

1 Open a new file in Microsoft Word. Do so by opening the app shaped like a blue W. Then click on File in the menu bar at the top of the screen, and click on New Blank Document. 2 Click on File in the menu bar and then Options in the menu. On Mac, click on Word in the menu bar and then Preferences… in the menu.
3 Click on Customize Ribbon and then Main Tabs in the "Customize the Ribbon:" drop-down menu."[1] On Mac, click on Ribbon & Toolbar in the "Authoring and Proofing Tools" section of the dialog box, then click on the Ribbon tab at the top of the dialog box. 4 Check "Developer" in the "Main Tabs" pane. 5 Click on Ok. 6
Click on Developer. It's a tab in the upper-right part of the window. 7 Position the cursor where you'd like to insert the check box. 8 Click on Check Box. It's in the menu bar at the top of the window. 9 Add additional check boxes and text as needed. 10 Lock the form. To do so, select the entire list, to be found in the
Controls section on the Developer tab, then click on Group and Group. On Mac, click Protect Form in the Developer tab toolbar. Add New Question Question What should I do if the check box is grayed out in my ribbon? It is grayed out for me too. However, if you click on the one icon that isn't -- Legacy Tools -- then you
will find the exact same checkbox, which you should be able to select. Question How can I enlarge the size of a text box without enlarging the text? In Word, just dragging the corner of the text box should be sufficient. If the text changes size accidentally, you can always highlight it and change it back to the desired size.
Question How do you make a drop box in word? Download LibreOffice. Follow the manual on how to add a list or list/add or list/multiselect box (or just look under "insert" in the menu). You can add a data source for the dropdown menu items from a database, a spreadsheet or within the file structure itself. Question How
do I add text following a check box? Just insert a text box next to the check box and type your text into it. Question How do I remove the two shaded blue boxes on either side of my tick box in Word? Right-click; Remove Content Control. This will get rid of the boxes. Question How do I delete a checkbox from Word? Put
the cursor on the right of it, put it close as you can and hit the delete button. Question How do I insert a check mark? Highlight the box (press the 3 dots next to the box) > under the developer tab, press properties > under check box properties, next to checked symbol, press change > next to font, select wingdings 2, and
at the bottom, enter 82 next to character code > press ok > ok. Question How do I insert a fill-in text box in Word? Go to the insert tab > press the arrow under table > press the top left square, it will open a 1x1 table. Resize and position the table any way you like - when the person you send it to opens the document,
they should be able to click in that box and type text (I recommend you test this on your end before you send it). Question How do I change the cross to a check mark in MS Word? Highlight the box (press the 3 dots next to the box) > under the developer tab, press properties > under check box properties, next to
checked symbol, press change > next to font, select wingdings 2, and at the bottom, enter 82 next to character code > press ok > ok. Question How do I change the cross to a tick? Highlight the box (press the 3 dots next to the box) > under the developer tab, press properties > under check box properties, next to
checked symbol, press change > next to font, select wingdings 2, and at the bottom, enter 82 next to character code > press ok > ok. Ask a Question This article was co-authored by our trained team of editors and researchers who validated it for accuracy and comprehensiveness. wikiHow's Content Management Team
carefully monitors the work from our editorial staff to ensure that each article is backed by trusted research and meets our high quality standards. This article has been viewed 1,034,480 times. Co-authors: 12 Updated: September 3, 2020 Views: 1,034,480 Categories: Microsoft Word Print Send fan mail to authors Thanks
to all authors for creating a page that has been read 1,034,480 times. "Sincerely appreciate the thorough and accurate instructions. Saved me a lot of time and headache. Thank you." Share your story When you create surveys or forms with Microsoft Word, check boxes make the options easier to read and answer.
We’re covering two good options for doing just that. The first is ideal for documents that you want people to fill out digitally within the Word document itself. The second option is easier if you’re planning to print documents like to-do lists. Option 1: Use Word’s Developer Tools to Add The Check Box Option for Forms
RELATED: How to Create Fillable Forms with Microsoft Word In order to create fillable forms that include check boxes, you first need to enable the “Developer” tab on the Ribbon. With a Word document open, click the “File” drop-down menu and then choose the “Options” command. In the “Word Options” window, switch
to the “Customize Ribbon” tab. On the right-hand “Customize the Ribbon” list, select “Main Tabs” on the dropdown menu. On the list of available main tabs, select the “Developer” check box, and then click the “OK” button Notice that the “Developer” tab is added to your Ribbon. Just position your cursor in the document
where you want a check box, switch to the “Developer” tab, and then click the “Check Box Content Control” button. You should see a check box appear wherever you placed your cursor. Here, we’ve gone ahead and placed a check box next to each answer and, as you can see, those check boxes are interactive. Click a
box to mark it with an “X” (as we’ve done for answer 1) or select the whole form box (as we’ve done for answer 2) to move the check box around, format it, and so on. Option 2: Change Bullets to Check Boxes for Printed Documents If you’re creating a document to print out—like a to-do list or printed survey—and just
want check boxes on it, you don’t have to mess around with adding Ribbon tabs and using forms. Instead, you can create a simple bullet list and then change the bullets from the default symbol to check boxes. In your Word document, on the “Home” tab, click the small arrow to the right of the “Bullet List” button. On the
dropdown menu, select the “Define new bullet” command. In the “Define New Bullet” window, click the “Symbol” button. In the “Symbol” window, click the “Font” dropdown and choose the “Wingdings 2” option. You can scroll through the symbols to find the empty square symbol that looks like a check box, or you just type
the number “163” into the “Character Code” box to automatically select it. Of course, if you see a symbol you like better—like the open circle (symbol 153)—feel free to choose that instead. When you’ve selected your symbol, click the “OK” button to close the “Symbol” window, and then click the “OK” button to close the
“Define New Bullet” window, too. Back in your Word document, you can now type your bullet list. The check boxes appear instead of the regular bullet symbol. And the next time you need the check box symbol, you don’t have to navigate through that whole set of windows. Just click that small arrow to the right of the
“Bullet List” button again, and you’ll see the checkbox listed under the “Recently Used Bullets” section. Again, this method is really only useful for documents you want to print out. The check box symbols are not interactive, so you can’t check them off inside a Word document. To insert decorative bullets: Select Home >
Bullets > Define New Bullet > Symbol. To add functional bullets: Select File > Options > Customize Ribbon > Main Tabs > Developer > Controls > Check Box Content Control. This article explains how to insert two types of check boxes into a Word document: check boxes that are decorative only and are useful in printed
documents and check boxes that can be checked electronically in the document. This tutorial applies to Word 2010 and above on macOS or Windows operating systems. Placing check boxes in your document strictly for visual purposes, whether on paper or on screen, is a simple process. You can't add a check mark to
them within Word. Select a location in the Word document. Select the Home tab if it is not already selected. Choose the drop-down list accompanying the Bullets button. When the Bullet Library pop-out appears, select Define New Bullet. The Define New Bullet dialog displays, overlaying the main Word window. Select
Symbol. Scroll the symbols list until you locate one suitable to use as a check box, clicking it once to select it. If you do not see an option that you like, choose a different value from the Font drop-down list—Webdings, for example—to peruse additional sets of symbols. Microsoft Word supports special characters such as
bullets, copyright and trademark symbols, various styles of arrows, and related glyphs. Select OK when you've made your choice. Lifewire / Scott Orgera From the Define New Bullet interface, select OK. If you followed the instructions correctly, the check box should now be added to your document. In addition to visual
symbol, Word supports functional check boxes. These come in handy for online checklists or other types of forms that require user interaction. Select File > Options. In the Word Options dialog, select Customize Ribbon. Under Customize the Ribbon, choose the Main Tabs option from the drop-down menu. Locate the
Developer option and select + to expand the list. Place a check mark next to Developer by selecting its accompanying check box once. Select + next to the option labeled Controls, expanding its list as well. Select Check Box Content Control and select OK to return to the main Word interface. Activate the Developer tab,
now added to the main menu toward the top of your screen. In the Controls section, select the check box icon. A new check box should now be inserted into your document. By default, an X appears in the check box when someone clicks it. This symbol can be changed, along with many other attributes of the new check
box. Select it, then select Properties. From here you can modify the appearance of both checked and unchecked symbols, as well as the behavior of the check box itself when used within your electronic document. Thanks for letting us know! Tell us why! We live in a world of checklists and checkboxes, so it stands to
reason you might sometimes want to include checkboxes in documents you create.There are two different kinds of checkboxes you can create in Microsoft Word: decorative ones for printed documents (that can be checked off in real life with a pen or pencil), and functional checkboxes that users can check with a mouse
click if they're viewing the document on a computer. How to insert a checkbox in Word for printed documents1. Position the cursor where you want to place the checkbox in your Word document. 2. In the ribbon at the top of the screen, make sure you're on the "Home" tab and then click the down-arrow beside the Bullets
button.3. In the drop-down menu, click "Define New Bullet." Click the arrow to display the drop-down menu and then choose to define a new bullet. Dave Johnson/Insider 4. Click "Symbol."5. In the Symbol dialog box, find a symbol that looks like a checkbox. There are a number of options to choose from, but here's a
good choice: In the "Font" drop-down, choose "Wingdings 2" and then in the "Character code" field, enter "163." If you like this option, click "OK." Find a checkbox style you like — many people use character 163 in Wingdings 2, but there are many other similar options. Dave Johnson/Insider 6. Click "OK" again to close
the other open window. 7. The checkbox will now be added to your document. To add more checkboxes, just use the Bullet button and it'll be inserted automatically (to get your usual bullet back, click the down-arrow next to the Bullet button and choose the symbol you prefer). In the future, you can choose either the
usual bullet or the checkbox from the menu without needing to select it from the "Define New Bullet" dialog box. You can get back to the checkbox symbol from the Bullets menu. Dave Johnson/Insider How to insert a checkbox in Word for electronic documentsIf you want a "clickable" checkbox in electronic documents,
you'll need to enable the Developer ribbon in Options. You'll only need to do that once, and then you can add a functional checkbox anytime you need it. 1. In the ribbon at the top of Word, click the "File" tab and then click "Options." Open "Word Options" from the "File" tab of the ribbon. Dave Johnson/Insider 2. In the
Word "Options" dialog box, click "Customize Ribbon" in the navigation pane on the left.3. In the "Customize the Ribbon" section on the right, choose "Main Tabs" from the drop-down menu and then click the checkbox for "Developer" in the list. Enable the "Developer" options so it appears as a tab in the ribbon. Dave
Johnson/Insider 4. Click "OK" to close Word Options. 5. In the ribbon, click the new "Developer" tab.6. In the "Controls" section, click the checkbox icon. You should see it appear in the document. It's clickable – you can make it appear checked or unchecked by clicking. You can now add clickable checkboxes to your
documents. Dave Johnson/Insider If you prefer, you change the way the checkbox appears when it's clicked. To customize it, do this: You may need to add check boxes in your Word document mainly for two reasons: 1)     To create an electronic Form containing clickable checkboxes, which can be used to capture user
feedback (like a survey); see the following example: 2)     To create a printable checklist, containing a checkbox against each item in the document. See the following example: Adding checkbox controls to create a electronic Form (Word 2007) You can find the checkbox control on the Developer tab of the Ribbon menu.
Note: If you could not see the Developer tab on the Ribbon, you may need to enable it from Word Options. Read the following article to know how to enable it. On the Ribbon, under the tab Developer, within the group Controls, click the icon Legacy Tools. A drop-down list appears, which contains two sections: Legacy
Forms and ActiveX Controls. See below. ActiveX Control checkbox Both the sections have check box controls. If you choose to use the checkbox control available under ActiveX Controls section, click the Checkbox (ActiveX Control) icon. Word creates something like the following. Notice that the control is in Design
Mode. Design Mode option is activated within the group Controls. If you deactivate the design mode, the  checkbox becomes clickable and you can use it to create a Form. i.    Right-click the checkbox control and select option Properties from the right-click menu. ii.    On the Properties sheet, under the tab Alphabetic,
against the row Caption, enter a caption for the checkbox. Alternatively, you can delete the default caption to retain only the checkbox. You can even insert a picture instead by clicking the row named Picture from the Properties sheet. Note: The ActiveX Control checkbox provides extended features as compared to the
Legacy checkbox. iii.    You may find it difficult to format ActiveX checkbox controls if you are not in Design Mode. Switch to design mode by clicking the control. Now, place mouse cursor in front of the control and then use the TAB key to move it horizontally, SHIFT+TAB to move it in the opposite direction, press ENTER
key to move it a step down, and press the Backspace key to bring it a level up. Note: You can easily delete, resize, etc. in Design Mode. Legacy check box If you choose to use a legacy checkbox, click the check box icon under the section Legacy Forms from the Legacy Tools drop-down list. Word creates a shaded
square box, which is unchecked by default. Double-click the box to open the Check Box Form Field Options window. Here, you can control the checkbox size, default value, etc. Note: Interestingly, the legacy check boxes cannot be used readily until you apply protection to your document. By default, Word adds a shaded
checkbox. If you wish you can remove the shading by simply clicking the Form Field Shading icon available under the Legacy Tools list. See below image. Apply protection to your document i.    To apply protection to your document, under the tab Developer, within the group Protect, click Protect Document. From the
drop-down menu, click option Restrict Formatting and Editing. ii.    On the Restrict Formatting and Editing pane, under the section Editing Restriction, enable option “Allow only this type of editing in the document” and then select the option “Filling in forms” from the list box. iii.    Now, under the section Start Enforcement,
click the button Yes, Start Enforcing Protection. The Start Enforcing Protection dialog box appears, where  you need to set a password to protect your document. Once protection is  enforced, you can select/deselect the check box. Remember that you cannot edit a protected document. Therefore, apply protection only
after you are done with formatting the document. You can unprotect a document by clicking the Stop Protection button available at the bottom of the Restrict Formatting and Editing pane. Creating a printable check list It is easy to add checkboxes to a document to create a printable checklist document. There are many
ways you can create check boxes in a word document. Method 1: On the Word Ribbon menu, under the tab Developer, within the group Controls, click the Legacy Tools icon. From drop-down list, under the section Legacy Forms, click the Check Box Form Field icon. Word inserts a shaded check box. Click the Form
Field Shading icon to  remove shading around the checkbox. Now, you can copy and paste the same to create multiple checkboxes in your document. Method 2: On the Word Ribbon menu, under the tab Insert, within the group Illustrations, click icon Shapes. From the drop-down list, click the shape Rectangle. Change
its dimensions  to make it a perfect square. Copy and paste the same to create multiple checkboxes. Method 3: On the Word Ribbon menu, under the tab Insert, within the group Symbols, click icon Symbol. From bottom of the drop-down list, select option More Symbols. From the Symbols window, select a square shape
and then click Insert. Word inserts a square at the cursor position.
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